English Language Proficiency Assessments for California

Test Operations Management System Guide for the ELPAC

♦ Local Educational Agency ELPAC Coordinators ♦ Site ELPAC Coordinators ♦ ELPAC Test Examiners

Initial Assessment
Summative Assessment

ELPAC
English Language Proficiency Assessments for California

ETS®
Measuring the Power of Learning™

Posted December 2017
Prepared by Educational Testing Service ©
Contact Information

If this document does not answer your questions, Site English Language Proficiency Assessments for California (ELPAC) Coordinators and/or ELPAC Test Examiners should contact their local educational agency (LEA) ELPAC Coordinators, who will contact the ELPAC Customer Support Center for additional support.

ELPAC Customer Support Center

  Telephone: 844-782-2714
  E-mail: ELPAC@ets.org

ELPAC Customer Support Center hours:

Monday–Friday 7:30 a.m. to 5 p.m., Pacific time

Always include the following information:

- LEA ELPAC Coordinator, Site ELPAC Coordinator, or ELPAC Test Examiner name and IT/network contact person and contact information
- Statewide Student Identifier(s)
- Operating system and browser version information
- Any error messages and codes that appeared, if applicable
- Information about your network configuration:
  – Wired or wireless Internet network setup

Warning: Never provide any other student information (e.g., student name, birthdate, etc.), as doing so may violate Family Educational Rights and Privacy Act policies.
# Table of Contents

**Chapter 1. Introduction** .................................................................................................................1  
Features of This Version of the Test Operations Management System (TOMS) ...........................................2  
About TOMS .........................................................................................................................................3  
TOMS Functionality for ELPAC Coordinators and ELPAC Test Examiners ...........................................3  
TOMS Requirements ...............................................................................................................................3  
Gaining Access to TOMS .......................................................................................................................3  
About This Manual ....................................................................................................................................5  
Document Conventions ..............................................................................................................................5  

**Chapter 2. Passwords, Access, and Logon** .......................................................................................7  
Accessing the English Language Proficiency Assessments for California (ELPAC) Test Operations Management System (TOMS). ......................................................................................................................8  
General Steps to Log On .........................................................................................................................8  
New Users—Setting a New Password ......................................................................................................11  
Existing Users—Reseting a Password .....................................................................................................13  
Obtain the Secure Link for a Forgotten Password ................................................................................13  
Set the Password ......................................................................................................................................15  

**Chapter 3. TOMS Application Overview** .........................................................................................17  
Orientation to the English Language Proficiency Assessments for California (ELPAC) Test Operations Management System (TOMS) Dashboard ........................................................................................................18  
ELPAC TOMS Icons ...............................................................................................................................18  
Application Icons ....................................................................................................................................19  
ELPAC TOMS Left Navigation Bar ..........................................................................................................19  
Using the TOMS Dashboard ....................................................................................................................21  
Create an Announcement for the TOMS Dashboard ..............................................................................21  

**Chapter 4. Organizations** ..................................................................................................................23  
Managing Organizations ..........................................................................................................................24  
Search for an Organization .......................................................................................................................25  
[General Info] Tab ..................................................................................................................................25  
[Addresses] Tab ........................................................................................................................................26  
[Users] Tab ...............................................................................................................................................28  
[Contacts] Tab .........................................................................................................................................29  

**Chapter 5. Adding and Managing Users** ..........................................................................................31  
Adding and Managing Users in the English Language Proficiency Assessments for California (ELPAC) Test Operations Management System (TOMS) .....................................................................................32  
Module Overview .......................................................................................................................................32  
Adding Users ............................................................................................................................................33  
Viewing and Editing Users ......................................................................................................................42  
Reactivating a User .................................................................................................................................45  
Resetting a User's Password ....................................................................................................................46  

**Chapter 6. Student Search** ..................................................................................................................48  
View Students ..........................................................................................................................................49  

**Chapter 7. Ordering Test Materials** ..................................................................................................52  
Approving Orders .......................................................................................................................................53  
Module Overview .......................................................................................................................................53  
Approve an Order .......................................................................................................................................53  
View Summary Orders ..............................................................................................................................59  
View and Track Orders ..............................................................................................................................60  
Place a Supplemental Order ....................................................................................................................62  

---
Chapter 1. Introduction
The TOMS system for the English Language Proficiency Assessments for California (ELPAC) is similar in many ways to the TOMS system used for the California Assessment of Student Performance and Progress (CAASPP). However, because of different program requirements, there are several differences between ELPAC TOMS and CAASPP TOMS.

### Table 1. Differences between ELPAC TOMS and CAASPP TOMS

<table>
<thead>
<tr>
<th>ELPAC TOMS</th>
<th>CAASPP TOMS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TOMS Application</strong></td>
<td></td>
</tr>
<tr>
<td>Provides access to local educational agency (LEA) ELPAC and Site ELPAC Coordinators to perform tasks in support of the program, including providing organization information, adding and managing users, searching and viewing student information, viewing reports, accessing audio files, and accessing training information.</td>
<td>Provides access to LEA and Site coordinators to perform tasks in support of the program, including providing organization information, adding and managing users, searching and viewing student information, viewing reports, and accessing training information.</td>
</tr>
<tr>
<td>Includes the ELPAC logo and a blue and gold color scheme.</td>
<td>Includes the CAASPP logo and a color scheme featuring green and shades of blue.</td>
</tr>
<tr>
<td><strong>TOMS Functions</strong></td>
<td></td>
</tr>
<tr>
<td>ELPAC users must enter a primary shipping address.</td>
<td>For CAASPP users, the primary shipping address is populated from the California Longitudinal Pupil Achievement Data System.</td>
</tr>
<tr>
<td>ALL LEAs administering the ELPAC access TOMS to create, edit, and approve orders.</td>
<td>Only LEAs administering Smarter Balanced paper-pencil tests use the CAASPP TOMS ordering function.</td>
</tr>
<tr>
<td>ELPAC TOMS allows LEA ELPAC Coordinators to opt in to request Pre-identification (Pre-ID) labels be produced for the LEA with a purchase order.</td>
<td>LEAs ordering paper-pencil test materials for Smarter Balanced Summative Assessments are automatically assigned Pre-ID labels by CAASPP TOMS.</td>
</tr>
<tr>
<td>There is an Audio Modules section through which ELPAC Test Examiners play an audio file during the Listening domain of the ELPAC.</td>
<td>This function is unnecessary in TOMS for the CAASPP assessments.</td>
</tr>
<tr>
<td>The left navigation bar includes a separate [Site] button under [Reports] through which a Site ELPAC Coordinator may access a school-level demographics report.</td>
<td>Reports for test sites are included on the Reports Web form.</td>
</tr>
</tbody>
</table>
About TOMS

TOMS is a secure Web site that permits LEA ELPAC Coordinators to perform several tasks for the ELPAC testing program.

TOMS Functionality for ELPAC Coordinators and ELPAC Test Examiners

Depending on your role, you will be able to perform the following tasks in TOMS:

- Download materials such as ELPAC training materials and Frequently Asked Questions
- View news and announcements
- Administer the Listening domain to students in grades three through twelve

TOMS Requirements

TOMS supports the following Web browsers:

- Internet Explorer 10 and above
- Mozilla Firefox 45 and above
- Google Chrome 51 and above
- Safari 7 and above
- Google Android (all)
- iPad Safari (all)

System functionality and screen displays may operate or appear differently due to different Web browser and operating system capabilities. The TOMS Web site is optimal when viewed using a resolution of 1280 x 1024.

Important: While it is possible to open more than one Web browser tab or window at a time, only one Web browser tab or Web browser application window should be open for editing at one time.

Gaining Access to TOMS

LEA ELPAC Coordinators, Site ELPAC Coordinators, and ELPAC Test Examiners may access TOMS only after participating in the ELPAC training and after completing the proper security forms:

- Test Security Agreement for LEA ELPAC and Site ELPAC Coordinators
- ELPAC Test Security Affidavit

Once training has been completed, the LEA ELPAC Coordinator, Site ELPAC Coordinator, and ELPAC Test Examiner will receive an e-mail to verify his or her username (which is the user's e-mail address) and given a temporary password that will allow access to TOMS.
Note: If necessary, ask your LEA e-mail administrator to white list the e-mail address ELPAC@ets.org to ensure you receive your logon credentials.
About This Manual

1. This manual provides the instructions necessary for LEA ELPAC Coordinators and Site ELPAC Coordinators to manage users, order materials, and provide support to ELPAC Test Examiners in delivering audio modules for the Listening domain. Chapter 2 Passwords, Access, and Logon provides instructions for users in all assigned roles to access ELPAC TOMS.

2. Web site users may notice slight differences between what is displayed on the Web page and the screen captures shown in this manual due to individual browser versions, monitor resolution, PC configuration, etc.

3. Data displayed on the Web pages or forms shown as examples in this manual are for demonstration purposes only and may not reflect valid data.

4. Web pages may appear slightly different under Macintosh, using various versions of Windows, or because of differences in Web browsers or Web browser versions.

Document Conventions

Table 2 lists key symbols and typographical conventions used in this manual.

Table 2. Key Symbols and Document Conventions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Warning" /></td>
<td><strong>Warning:</strong> This symbol accompanies important information regarding actions that may cause fatal errors.</td>
</tr>
<tr>
<td><img src="image" alt="Caution" /></td>
<td><strong>Caution:</strong> This symbol accompanies important information regarding a task that may cause minor errors.</td>
</tr>
<tr>
<td><img src="image" alt="Note" /></td>
<td><strong>Note:</strong> This symbol accompanies additional information that may be of interest.</td>
</tr>
<tr>
<td><img src="image" alt="Additional Resources" /></td>
<td><strong>Additional Resources:</strong> This symbol accompanies a list of URLs for Web pages and/or Web documents that provide additional information.</td>
</tr>
<tr>
<td><img src="image" alt="Bold Text" /></td>
<td>Bold text in brackets is used to indicate a link or button that is selectable.</td>
</tr>
</tbody>
</table>
Chapter 2. Passwords, Access, and Logon
Accessing the English Language Proficiency Assessments for California (ELPAC) Test Operations Management System (TOMS)

Additional Resources:
- ELPAC Web Site—http://www.elpac.org/

Caution: ELPAC users cannot access TOMS until they attend the ELPAC Administration and Scoring Training.

All new local educational agency (LEA) ELPAC Coordinators, Site ELPAC Coordinators, and ELPAC Test Examiners who do not have an account in the California Assessment of Student Performance and Progress (CAASPP) version of TOMS will receive an e-mail with a username and password for access to the ELPAC version of TOMS.

LEA ELPAC Coordinators, Site ELPAC Coordinators, and ELPAC Test Examiners who currently have access to CAASPP TOMS and who have been granted access to ELPAC TOMS by a superintendent, LEA ELPAC Coordinator, or Site ELPAC Coordinator can use their existing CAASPP username and password to access ELPAC TOMS. These users will receive an e-mail verifying their ELPAC TOMS access.

The e-mail will provide instructions for users to log on and reset their passwords in TOMS.

General Steps to Log On

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner (indicated in Figure 1).

The ELPAC Web Site

The English Language Proficiency Assessments for California (ELPAC) Web site serves as the portal for resources that a local educational agency will need to administer the ELPAC.
2. The Logon Web form, shown in Figure 2, appears.

3. By using or accessing this site you agree to the terms and conditions of use. Select the [Terms and Conditions of Use] link to read the full text.

4. Enter your username—which is your e-mail address—in the username field next to the [E-mail Address] person [ ] icon and your password in the Password field next to the [Password] lock [ ] icon in the Logon Web form, and then select the [Secure Logon] button. Note that the username and password are case sensitive.
   - All users should follow the process to request a new temporary password if the one you were sent has expired. This process is described in the subsection “Existing Users—Resetting a Password.”

5. When you log on to TOMS, you will proceed to the TOMS home page, which shows the TOMS Dashboard (Figure 3).
   - The TOMS Dashboard default is the News & Announcements tab. This feature will keep you informed of important announcements.
   - LEA ELPAC Coordinators also can use this feature to create announcements for the users in your organization.
   - You can return to the TOMS Dashboard at any time by selecting the [Dashboard] button near the top of the application window (indicated in Figure 3).
Figure 3. The TOMS Dashboard
New Users—Setting a New Password

Users who are new to the ELPAC and the CAASPP must establish their user credentials by creating a password and an answer to a security question to gain access to the 2017–18 ELPAC TOMS. They will receive an e-mail from CA-Assessments@ets.org that contains a link to a secure Web form where a password can be created. The link is found within the e-mail text, “To begin, visit the secure Web site to create a password.”

Warning: A free e-mail program such as Gmail or Yahoo! might forward the e-mail from CA-Assessments@ets.org directly to a spam or junk mail folder. If you requested an updated secure link e-mail, but do not see it in the application’s default Inbox, be sure to check automated folder destinations to make sure the e-mail was not routed incorrectly.

1. Select the secure link in the e-mail; the Reset Your Password Web form appears (see Figure 4).
   Note: The link in the e-mail is valid for 30 minutes. If the link is not used within 30 minutes, when you do select it, you will be prompted to enter your e-mail address in the E-mail Address field and select [Submit] to request a link.

2. When you select the secure link, the Reset Your Password Web form appears; enter a password in the Password field and re-enter it in the Confirm Password field (see Figure 4). The password must contain the following characteristics:
   - Minimum of 8 characters
   - Maximum of 16 characters
   - At least 3 of the following:
     - minimum of one uppercase letter
     - minimum of one lowercase letter
     - minimum of one number
     - minimum of one special character such as:
       ~ ! @ # $ % ^ & * ( ) - _ = + [ ] ; : , . < > / ?

   You will see an error message if your new password does not match the confirmation password or if your password does not meet the password criteria. Try again.

3. When you have successfully entered your password twice, select the [Submit] button. You will be prompted to set up the security question(s) on the Security Questions Web form using the Security question drop-down list and providing the answer in the Security answer field (see Figure 5).
4. Select the [Add an additional question.] link if you wish to add an additional layer of security to the process by creating another security question. Otherwise, select [Next].

5. Once you have logged on successfully, you will proceed to the TOMS Dashboard.
Existing Users—Resetting a Password

Existing users—those who have had user roles during previous test administration years—must reset their password and security question to gain access to the 2017–18 California assessment systems. Existing users will receive an e-mail from CA-Assessments@ets.org that contains a link to a secure Web form where a password can be created and a security question can be verified. The link is found within the e-mail text, “Visit the secure Web site.” However, if the link is not used within 30 minutes, you will be prompted to enter your e-mail address in the E-mail Address field and select [Submit] to request a link.

Warning: A free e-mail program such as Gmail or Yahoo! might forward the e-mail from CA-Assessments@ets.org directly to a spam or junk mail folder. If you requested an updated secure link e-mail, but do not see it in the application’s default Inbox, be sure to check automated folder destinations to make sure the e-mail was not routed incorrectly.

Obtain the Secure Link for a Forgotten Password

If you have forgotten your password, first access TOMS to request the password reset e-mail. If you are responding directly to the e-mail notification, follow the instructions in the next subsection, “Reset the Password.”

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner (indicated in Figure 6).

Figure 6. TOMS button on ELPAC.org
2. The Logon Web form appears (see Figure 7).

3. Select the [Forgot Your Password?] link on the Logon Web form.

4. Enter your e-mail address in the E-mail Address field on the Reset Your Password Web form, and then select the [Submit] button (see Figure 8).

5. Answer the security question in the Enter an answer field to verify your identity on the Reset Your Password Web form, and then select the [Submit] button (see Figure 9).
Reset the Password

1. Check your e-mail account that is used as your username for an e-mail from caaspp@ets.org that contains the secure link you will use to reset your password. **Note that the secure link will expire in 30 minutes.** If you are notified of an expired link by a message displayed on the Reset Your Password Web form, enter your password and then select the [Submit] button to request a new secure link.

2. When you select the secure link, the Reset Your Password Web form appears; enter a password in the **Password** field and re-enter it in the **Confirm Password** field (shown in Figure 10). The password must contain the following characteristics:
   - Minimum of 8 characters
   - Maximum of 16 characters
   - At least 3 of the following:
     - Minimum of one uppercase letter
     - Minimum of one lowercase letter
     - Minimum of one number
     - Minimum of one special character such as: ~ ! @ # $ % ^ & * ( ) - _ = + [ ] | ; : , . < > / ?
   
   You will see an error message if your new password does not match the confirmation password or if your password does not meet the password criteria. Try again.

3. When you have successfully entered your password twice, select the [Submit] button. You will be prompted to verify the security question(s) on the Security Questions Web form (see Figure 11).

4. Select the [Add an additional question.] link if you wish to add an additional layer of security to the process by creating another security question. Otherwise, select [Next].

5. Once you have logged on successfully, you will proceed to the TOMS Dashboard home page.
This page is intentionally left blank.
Chapter 3. TOMS Application Overview
Orientation to the English Language Proficiency Assessments for California (ELPAC) Test Operations Management System (TOMS) Dashboard

Additional Resources:
- ELPAC Web Site—http://www.elpac.org/
- 2018 ELPAC Summative Assessment Administration and Scoring Moodle Training Site—https://moodle.elpac.org/

Once you log on to the ELPAC TOMS system, you will be taken to the ELPAC TOMS Dashboard (see Figure 12). This dashboard is designed to provide easy access to the tasks and functions you will complete for ELPAC testing.

Notes:
- The TOMS Dashboard will change throughout the school year as the windows for particular functions open and close. If you do not see a task that you need to complete, please contact the ELPAC Customer Support Center or check the test calendar.
- If you see a name other than yours in the Dashboard bar (below the application window header), please log off and report this to your local educational agency (LEA) ELPAC Coordinator (if you are a Site ELPAC Coordinator or ELPAC Test Examiner), to your Site ELPAC Coordinator (if you are an ELPAC Test Examiner), or to your ELPAC Customer Support Center (if you are an LEA ELPAC Coordinator).

ELPAC TOMS Icons

The four icons across the top of the TOMS application window are shown in Table 3.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Function after Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard</td>
<td>Dashboard</td>
<td>Returns to the TOMS Dashboard</td>
</tr>
<tr>
<td>Profile</td>
<td>Profile</td>
<td>Opens to show information about yourself and allows you to update certain fields (but not the e-mail address, as the e-mail address also functions as the User ID)</td>
</tr>
<tr>
<td>Help</td>
<td>Help</td>
<td>Provides contact information for the ELPAC Customer Support Center as well as several other available resources available</td>
</tr>
<tr>
<td>Logout</td>
<td>Logout</td>
<td>Logs the current user off</td>
</tr>
</tbody>
</table>
Application Icons

Common Action Icons

What follows are action icons that can be found on ELPAC TOMS Web forms.

- Select the [Edit] pencil icon to edit information.
- Select the [Delete] trash can icon to delete information.
- Select the [Download] down-arrow icon to download a file.
- Select the [View] magnifying glass icon to view more information.

Common Status Icons

- The [Processing] circle-arrows icon shows that the file in question is processing.
- The [Processing Error] red-x icon shows that the file failed to process properly.
- The [Complete] check mark icon shows that the file processed properly.

ELPAC TOMS Left Navigation Bar

The left navigation bar also contains a set of buttons, some of which open sub-buttons. Each button corresponds to an ELPAC TOMS function. These buttons/functions are described in Table 4.

Table 4. Left Navigation Bar Options

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organizations</td>
<td>• View and edit specific organization(s) for which you have privileges</td>
</tr>
<tr>
<td>Users</td>
<td>• Add, view and edit, or upload users for whom you have TOMS oversight</td>
</tr>
<tr>
<td>Students</td>
<td>• Search, view, and edit student data</td>
</tr>
<tr>
<td>Pre-ID Labels</td>
<td>• Approve Round 1 and Round 2 Pre-ID labels</td>
</tr>
<tr>
<td>Orders</td>
<td>• Review, update, and approve materials orders</td>
</tr>
<tr>
<td></td>
<td>• View summary orders</td>
</tr>
<tr>
<td></td>
<td>• View and track orders</td>
</tr>
<tr>
<td></td>
<td>• Place supplemental orders</td>
</tr>
<tr>
<td>Reports</td>
<td>• View LEA and test site reports</td>
</tr>
<tr>
<td>Button Name</td>
<td>Function(s)</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Audio</td>
<td>• Permit LEA ELPAC Coordinators, Site ELPAC Coordinators, and ELPAC Test Examiners to play a sample audio recording before testing</td>
</tr>
<tr>
<td></td>
<td>• Permit ELPAC Test Examiners to play Listening and Speaking modules during testing</td>
</tr>
<tr>
<td>Training Resources</td>
<td>• Open the <a href="#">ELPAC Moodle Training</a> Web site</td>
</tr>
<tr>
<td>ELPAC.org</td>
<td>• Open the <a href="#">ELPAC.org Web Site</a></td>
</tr>
</tbody>
</table>
Using the TOMS Dashboard

Additional Resources:
- ELPAC Web Site—http://www.elpac.org/

Create an Announcement for the TOMS Dashboard

In the TOMS Dashboard, the area below the Welcome Bar is devoted to news and announcements. In this area, you will see any announcements that have been created for you, your role, or your organization. You can also create announcements for others within your organization to see. Take the following steps to create an announcement for the TOMS Dashboard:

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner.

2. Select the [Create Announcement] button in the “News & Announcements” section of the TOMS Dashboard (indicated in Figure 12), to open the Create Announcement screen.

3. Add a subject in the Subject field (see Figure 13). This is a required field.

![Figure 12. TOMS Dashboard and navigation buttons](image-url)
4. If you want your announcement to go to a specific organization, select an Organization. To make it available to users within the LEA, leave the Select Organization field blank.

5. To have your announcement seen by only those users with a specific user role, choose a role from the Role Types list. To make it available to users assigned to all roles, leave the selection on the default of All.

6. Set the window for the announcement to be active by choosing a start and end date. Select the calendar next to the Announcement Start Date or Announcement End Date field, and then select the appropriate dates. These are required fields.

7. Select whether to send the announcement as an e-mail in addition to the posted announcement by selecting one of the Send E-mail radio button options. This is a required field.

8. Enter your announcement in the Announcement Text field. There is a 255-character maximum for an announcement. This is a required field.

9. When you are finished and you want to post your announcement and send it by e-mail to a selected group if requested, select [SAVE]. Otherwise, to delete the announcement without sending or posting, select the [CLEAR] button.
Chapter 4. Organizations
Managing Organizations

Additional Resources:
- ELPAC Web Site—http://www.elpac.org/

The Organization function allows users to view and edit certain organizations based on permissions. You can use the search filters to view a specific organization. Organizational information is provided by the California Longitudinal Pupil Achievement Data System.

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner.

2. Select the [Create Announcement] button in the “News & Announcements” section of the TOMS Dashboard (indicated in Figure 12), to open the Create Announcement screen.

3. Select the [Organizations] button in the left navigation bar to begin (see Figure 14).

![Figure 14. View & Edit Organizations screen](image-url)
Search for an Organization

Take the following steps on the View & Edit Organizations screen to search for an organization to view or edit:

1. Select a radio button in the Organization Type section to choose whether the organization you are looking for is a local educational agency (LEA) or a school.
2. Select a radio button in the Organization Status section to choose whether the organization is active or inactive.
3. Enter either the Organization Name or the Organization Code. Users can use either the “Begins With” or “Contains” from the drop-down.
4. Select the [SEARCH] button to continue.

You may also select the [SEARCH] button without entering any criteria to see a list of organizations for which you have privileges. In either case, the “Results” section appears with a list of organizations (see Figure 15).

```
Results
We have found 3 entries matching your search criteria.
• To view the number of users at an LEA, select the number in the # of Users column.
• To view or edit the organization information, select the [Edit] (pencil) icon.
• Hover your mouse over the other icons (if present) in the Actions column for a description of additional actions available to some users.

<table>
<thead>
<tr>
<th>Organization</th>
<th>Type</th>
<th># of Users</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Elementary (000000000000000)</td>
<td>SCHOOL</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Sample Elementary District Level Program (000000000000000)</td>
<td>SCHOOL</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Sample Elementary School District (000000000000000)</td>
<td>LEA</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
```

Figure 15. Organization search results

Depending on the number of filters put in place for the search, you will have organizations that meet the search criteria from which to select. The results area contains all relevant organizations. Information about the organizations are in columns called Type, # of Users (assigned to that organization), and Actions. Select the [Edit] pencil icon to open the Organization Profile screen for that entity.

[General Info] Tab

The default Organization Profile tab is the [General Info] tab; the screen opens to this tab. The [General Info] tab contains basic information on the organization, including the Name, the Code, and the Status, as well as the Responsible Organization (see Figure 16).
Warning: The primary shipping address must be completed before orders and Pre-ID labels can be approved.

Use the Web form in the [Addresses] tab to create or edit the primary shipping address for the LEA. This Web form is shown in Figure 17.

Figure 16. Organization Profile, [General Info] tab
To create a primary shipping address:

1. If the shipping address can receive freight/pallet shipments, check the *Can receive freight shipment* box.

   **Caution:** If you change this to an address where the LEA will receive Pre-ID labels, be sure to change it back after Pre-ID labels are shipped or else the testing materials will be shipped to that same address.

2. Select the [create primary shipping address] link.
3. Fill out the required fields on the *Create Organization Primary Shipping Address* screen.
4. Select the [SAVE] button at the bottom of the page. A pop-up will appear to confirm that the address was saved.
5. Select the [CLOSE] button.

The primary shipping address for the organization is now entered; a pencil icon for editing and a trash can icon for deleting will appear.

Enter additional addresses to create a billing address and/or an organization reporting shipping address if these are different from the primary shipping address.
[Users] Tab

![User Profile Image]

**Figure 18. Organization Profile, [Users] tab**

The **[Users]** tab shows which users are associated with a particular organization. If there is more than one user in the system, one of the users will have a checkmark in the **Primary** column indicating that he or she is the primary designated user for the organization. There is a pencil icon to the right of each listed user, which opens the **Demographic Information** Web form to permit editing of subordinate users.

The primary LEA ELPAC Coordinator can edit the following information on this form:

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the user’s Demographic Information; you must select [SAVE] to save updated information</td>
</tr>
<tr>
<td>Deactivate a user</td>
</tr>
<tr>
<td>Reset a user’s password (which activates an inactive user)</td>
</tr>
<tr>
<td>Add a user</td>
</tr>
<tr>
<td>Remove a role from a user’s profile</td>
</tr>
<tr>
<td>Remove a user</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Select….</th>
</tr>
</thead>
<tbody>
<tr>
<td>[SAVE]</td>
</tr>
<tr>
<td>[DEACTIVATE]</td>
</tr>
<tr>
<td>[RESET PASSWORD]</td>
</tr>
<tr>
<td>[ADD ROLE]</td>
</tr>
<tr>
<td>[DELETE SELECTED]</td>
</tr>
<tr>
<td>[DELETE]</td>
</tr>
</tbody>
</table>

See **Chapter 5 Adding and Managing Users** for additional details about how to add users to ELPAC TOMS.
The [Contacts] tab allows the user to create as many additional contacts as needed for the organization. To create a contact:

1. Select the [CREATE CONTACT] button to open the Create Organization Contact Web form (see Figure 20).
2. Select the Contact Type from the drop-down list. Choices are as follows:
   - Superintendent/Charter School Administrator
   - LEA ELPAC Coordinator
   - Site ELPAC Coordinator
   - Billing Contact
   - Shipping Contact
   - Special Education Coordinator Contact

3. Enter the contact’s information including the individual’s name, address, e-mail address, and phone number.

4. Select the [SAVE] button.

5. Repeat for additional contacts.
Chapter 5. Adding and Managing Users
Adding and Managing Users in the English Language Proficiency Assessments for California (ELPAC) Test Operations Management System (TOMS)

Additional Resources:
- ELPAC Test Administration Web page—http://www.elpac.org/test-administration/

Module Overview

Local educational agency (LEA) ELPAC Coordinators may add Site ELPAC Coordinators to TOMS and may add ELPAC Test Examiners; Site ELPAC Coordinators can add ELPAC Test Examiners. A primary LEA ELPAC Coordinator can add another LEA ELPAC Coordinator only by contacting the ELPAC Customer Support Center. These roles enable the designated users to administer and manage ELPAC administration. Users may be added either individually in the TOMS user interface or in the batch upload of a .csv file.

Note the following about assigning users in TOMS:

- A user with different roles across different LEAs or test sites must use a separate e-mail account per each role.
- Each user can be assigned one TOMS account, no matter how many different LEAs or sites he or she is associated with, if the user level of access (role) is the same across all the sites.
- If a user is to be assigned roles that have different levels of access at multiple sites, he or she must use a unique e-mail address at each site.
- Assigning different levels of access at each site would also prevent a Site ELPAC Coordinator from creating a subordinate that has the same user role he or she has been assigned at a different site—for example, an individual who is a Site ELPAC Coordinator at School 1 and an ELPAC Test Examiner at School 2 cannot assign another individual as a Test Examiner at School 1.
- You should not assign an individual user to multiple roles at a single site; instead, grant the user the highest level of access among those roles at the site. For example, a user who is both a Site ELPAC Coordinator and an ELPAC Test Examiner should be assigned the role of Site ELPAC Coordinator.

Manage Security

It is the responsibility of the LEA ELPAC Coordinators to have, on file at the LEA, a signed ELPAC Test Security Agreement for LEA ELPAC Coordinator and Site ELPAC Coordinator Form from each Site ELPAC Coordinator to whom access has been granted.
Additionally, it is the responsibility of each LEA ELPAC Coordinator to have, on file at the LEA, an ELPAC Test Security Affidavit from each Test Examiner or other staff member to whom access to systems has been granted.

These forms are accessed on the ELPAC Test Administration Web page.

Reset Passwords

LEA ELPAC Coordinators can reset passwords for their Site ELPAC Coordinators in TOMS. Site ELPAC Coordinators should contact their LEA ELPAC Coordinators directly for this service.

Site ELPAC Coordinators can reset passwords for the ELPAC Test Examiners. Staff should contact their Site ELPAC Coordinators directly for this service. Note the following about resetting passwords:

- All users can reset their own existing passwords by following the instructions in the “Passwords, Access, and Logon” subsection.
- Passwords should be reset manually when a user has forgotten the answer to a security question and cannot reset it him- or herself.
- LEA ELPAC Coordinators must contact ELPAC Customer Support to have their password reset for them if the “Forgot Your Password?” process does not work.

Adding Users

LEA ELPAC Coordinators must add site users to TOMS to enable the designated users to administer and manage the ELPAC.

Once Site ELPAC Coordinators are added by their LEA ELPAC Coordinator and receive access to TOMS, they will have the ability to add ELPAC Test Examiners for their assigned site using the same methods in this section.

There are two methods LEA ELPAC Coordinators and Site ELPAC Coordinators can use to add users to TOMS:

1. One at a time
2. Bulk upload using a template (either blank or modifying a file of previous users)

Method 1—One at a time

Note: When you are adding users to TOMS using the one-by-one method, please allow up to two hours for the system to process the request and grant access to the added user.

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner.
2. When TOMS has opened, select the [Users] button in the left navigation bar to open the Create Users Web form (see Figure 21).
3. Select the [Add] button.

4. In the “Demographic Information” section, enter the following information for the user being added:
   - First name
   - Last name
   - E-mail address
   - Phone number
   - Fax number (optional)
Note that the e-mail domain extension portion of an e-mail address—the portion after the dot, (e.g., “.edu” or “.org”)—is limited to 10 characters.

5. Select the LEA or school that the user is associated with by selecting the [Select Organization] link. You also can perform this step as step 5.
   a. To view the LEA’s information, type at least five characters of the LEA’s name (including spaces) or the County-District-School (CDS) code for the LEA.
   b. To view a school’s information that is in your organization, type at least five characters of the school’s name (including spaces) or the CDS code of the school.

6. Based on the selected organization, select the radio button corresponding with the user’s role. These roles can be set by the LEA ELPAC Coordinator. The ELPAC Test Examiner role can also be created by Site ELPAC Coordinators.

7. Select [ADD ROLE]. You must add a role to successfully create a new user profile. ELPAC TOMS roles are as follows:
   - LEA ELPAC Coordinator
   - Site ELPAC Coordinator
   - ELPAC Test Examiner

8. Select [Close] on the Save User confirmation box.

9. Select [Save] when you are finished adding users.

10. Select [Close] on the Add a user confirmation box.

If the user already has a role in the system, you can delete that role by selecting the [Delete] icon in that role’s row in the “Roles in the System” section of the Web form.

Method 2—Adding Users in bulk via Template Upload

LEA ELPAC Coordinators and Site ELPAC Coordinators also have the option to upload TOMS users via batch upload of a file in .csv format. These users can download a template from TOMS and then manually enter all users.

Notes:
1. LEA ELPAC Coordinators should coordinate with Site ELPAC Coordinators to decide who will be uploading user information because if a user has already been assigned a role or made an active user within an organization, that role may be overridden in a subsequent upload of users within that organization.
2. When you are adding staff to TOMS using the template upload method, please allow up to two business days for the system to process the file and grant access to the added users.
3. LEA ELPAC Coordinators can submit only user information for schools within their LEA. Site ELPAC Coordinators can submit only user information for their school.
Step 1. Access TOMS.

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner.
2. Log on to TOMS.

Step 2. Download a file.

Download the blank template in TOMS. Note that the blank template includes a worksheet that contains the file specifications.

**Download the blank template**

1. Open TOMS.
2. Select the [Users] button in the left navigation bar.
3. Select the [Upload Users] button in the left navigation bar.
5. Save the template locally.

Step 3. Edit the users.

While the downloaded .csv file is best updated using Notepad or another plain-text editor, you can update it in Microsoft Excel by using one of the following two options: provided you

1. either copy the contents of the downloaded file into a different spreadsheet or save the .csv file into an Excel format such as .xlsx, and then
2. save it as a .csv file when you are finished editing your user information.

When you create the list of users in a blank template, you can copy or enter the user information into the template. The specifications for each record in the template, including maximum length, required or not, and acceptable value for the field, are described in the [User Upload File Specifications] tab of the user upload template. You must enter data in every field, columns A–F.

**Notes:**

- If you choose to copy the contents of a .csv file into a spreadsheet, make sure that the format applied to the CDS Code column in the alternate spreadsheet is “Number with no decimal places” or else the contents may show in scientific notation (e.g., 1.2408E+12).
- If you choose to edit the contents of the .csv file in a plain-text editor, be careful that your data do not include commas, which are used to separate data fields within comma-delimited records.

When you are finished, save as a .csv file using the *File > Save As* option in Excel.

1. With the template tab visible, select *File > Save As* and then the [Browse] button to select the location where you would like to save the file (see Figure 22).

![Figure 22. File > Save As in Excel](image)

2. In the Save As window, enter a name for the file in the *File name:* field (see Figure 23).

![Figure 23. Save a template](image)
3. Select CSV (Comma delimited) (*.csv), as appropriate, from the Save as type: drop-down list.

4. Select the [Save] button.

5. When prompted by the “The selected file type does not support workbooks that contain multiple sheets” alert box, select [OK] to continue.

6. When prompted by the “Some features in your workbook might be lost if you save it as CSV (Comma delimited)” information box, select [Yes] to continue.

**Step 5. Validate the file in TOMS.**

1. Access TOMS.

2. Select the [Users] button on the left navigation bar (see Figure 21).

3. Select the [Upload] button on the left navigation bar (see Figure 21).

4. In the “Validate File” section of the Upload Users Web form, select the [Browse] (Internet Explorer or Firefox) or [Choose File] (Chrome) button (see Figure 24).

5. Locate and select the file.

**Figure 24. Prepare to validate a file**
6. Confirm that the correct file is selected, and then select the [VALIDATE] button to upload the users file.

7. If the validation is successful—that is, there are no errors in the file—you will receive an e-mail noting that the file is error free, and the [UPLOAD] button will appear in the “File Validation Results” section.

If there are one or more errors in the Errors column after validation, you will receive an e-mail notification with the number of errors in the file; take one of the following actions:

1. Select the number in the Errors column corresponding to a file to see any errors in the submitted file.

2. In the Actions column, select the [Download] (down-arrow) icon to download a .csv file that contains a list of the errors in the submitted file.

3. Correct the errors and then revalidate your file.

Step 6. Upload the file into TOMS.

If there are zero errors in the Errors column after validation, select the [UPLOAD] button to upload your file into TOMS.

Your file will appear in the “Uploaded Files” section of the screen after it has been uploaded. If there are one or more errors in the Errors column, take one of the following actions:

1. Access TOMS.

2. Select the [Users] button on the left navigation bar (see Figure 25).

3. Select the [Upload Users] button on the left navigation bar (see Figure 25).
Adding and Managing Users in the English Language Proficiency Assessments for California (ELPAC) Test Operations Management System (TOMS)

Figure 25. Upload [Process File] Web form
4. Upload your completed .csv file into the “File Validation Results” section of the Upload [Process File] Web form by selecting the [UPLOAD] button for the appropriate file in this section’s list of files (see Figure 25).

5. You will receive an e-mail from elpac@ets.org verifying the upload that includes whether or not the upload was successful. (An unsuccessful upload is usually due to a network issue or system error.)

**Step 7. Check the status of an uploaded file.**

1. Select the [Users] button on the left navigation bar (see Figure 25).
2. Select the [Upload Users] button on the left navigation bar (see Figure 25).
3. Look for the file in the “Uploaded Files” section (see Figure 26).

![Figure 26. “Uploaded Files” section](image)

4. Data shown are as follows:

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>Counter for the file upload identification number in the “Uploaded Files” section</td>
</tr>
<tr>
<td>Date</td>
<td>Date the file was uploaded</td>
</tr>
<tr>
<td>Filename</td>
<td>Name given to the file by the LEA CAASPP or CAASPP test site coordinator</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the file; statuses are:</td>
</tr>
<tr>
<td>![Icon] (Processing)</td>
<td>A file upload is in process.</td>
</tr>
<tr>
<td>![Icon] (Complete)</td>
<td>A file upload was successful.</td>
</tr>
<tr>
<td>![Icon] (Processing Error)</td>
<td>A file upload failed.</td>
</tr>
<tr>
<td>Errors</td>
<td>Number of records/rows with data errors (Select the link—the number in the column, which shows the number of errors—for more details on the errors.)</td>
</tr>
</tbody>
</table>
Adding and Managing Users
Adding and Managing Users in the English Language Proficiency Assessments for California (ELPAC) Test Operations Management System (TOMS)

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions</td>
<td>Available actions that can be taken; actions are:</td>
</tr>
<tr>
<td>Icon</td>
<td>Icon name</td>
</tr>
<tr>
<td>[Delete File]</td>
<td>Delete the uploaded file.</td>
</tr>
<tr>
<td>[Expired]</td>
<td>There were changes to the validated user ID between the time the file was validated and the time it was available. The file must be revalidated.</td>
</tr>
<tr>
<td>[Download Errors]</td>
<td>Download the report of file errors.</td>
</tr>
</tbody>
</table>

5. If the file upload failed (that is, if you see the [Processing Error] icon in the Status column), the cause could be a network or system error. Revalidate your file and upload your file again.

Note: Removing items from the Uploaded Files list affects the text in the list only, it does not affect the user information in the file that was loaded successfully.

Viewing and Editing Users

On the View & Edit Users Web form, you can search, view, edit, and deactivate roles from other users (see Figure 27).

1. Open TOMS.
2. Select the [Users] button in the left navigation bar.
3. Select the [View& Edit] button in the left navigation bar.
4. To find a user, enter criteria in the different search fields in the “Search for a User to View and Edit” section and select [SEARCH]; or just select [SEARCH] to show all the users within the organization with the exception of the searcher).

5. To edit a user, select the [Edit] pencil [edit] icon in the Actions column in the row for the user (circled in Figure 27). The Demographic Information (User) Web form, shown in Figure 28, appears.

---

**Figure 27. Search for a User Web form**
Figure 28. Edit Demographic Information (User) Web form
6. You can take the following actions on the Demographic Information Web form:

<table>
<thead>
<tr>
<th>Action</th>
<th>Select....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the user’s Demographic Information; you must select [SAVE] to save updated information</td>
<td>[SAVE]</td>
</tr>
<tr>
<td>Deactivate a user</td>
<td>[DEACTIVATE]</td>
</tr>
<tr>
<td>Reset a user’s password (which activates an inactive user)</td>
<td>[RESET PASSWORD]</td>
</tr>
<tr>
<td>Add a user (follow the instructions in the “Adding Users One by One” subsection)</td>
<td>[ADD ROLE]</td>
</tr>
<tr>
<td>Remove a role from a user’s profile</td>
<td>[DELETE SELECTED]</td>
</tr>
<tr>
<td>Remove a user</td>
<td>[DELETE] [🗑️]</td>
</tr>
</tbody>
</table>

**Reactivating a User**

You can reactivate a user by either including that user in the .csv file using the batch upload process, following the steps to add a user using the one-by-one process, or, if the user is present but with a status of “inactive,” assigning a role and selecting the [RESET PASSWORD] button on the Edit Demographic Information (User) Web form (see Figure 28).
Resetting a User’s Password

LEA ELPAC Coordinators can reset any temporary or existing password for Site ELPAC Coordinators and other LEA and school staff. Site ELPAC Coordinators can reset passwords for school staff. Additionally, a password reset for an inactive user reactivates that user. Active users can also reset their own password on the Logon Web form.

Note: Users will receive an e-mail with a link to a secure Web site where they can create a new password. The link expires in 30 minutes.

To reset a password in the Test Operations Management System (TOMS):

1. Open TOMS.
2. Select the [Users] button in the left navigation bar to open the Search for a User to View and Edit Web form.
3. Follow the instructions in the “Viewing and Editing Users” subsection of this manual, or scroll to the bottom of the Web form to the “Results” section to see a list of users with whom you are associated.
4. Select the [Edit] pencil icon in the Actions column in the row of the user whose password you will be resetting. The Demographic Information (User) Web form, shown in Figure 29, opens.
5. Select the [RESET PASSWORD] button to reset the password; select [Close] to confirm.

The user will receive an e-mail with a secure link to the Reset Password Web form.
Chapter 6. Student Search
View Students

Additional Resources:
- English Language Proficiency Assessments for California Web Site—http://www.elpac.org/

In the View Students Web form, you can search, view, and edit individual student data.

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner.

2. Select the [Students] button in the left navigation bar to open the View Students Web form; begin by selecting criteria to search for a student or students (see Figure 30).

3. Enter details about the student—such as the first or last name, Statewide Student Identifier, Gender, Grade, enrollment status, or English-language acquisition status—in the search fields in the “Search for Students” section (see Figure 30); use the Select Filter drop-down lists to narrow your search (options are Begins With and Contains), or
select the local educational agency (LEA) you are associated with by selecting the [Select Organization] link.

a. To pull up all students in an associated organization, do not specify any search criteria.

b. To view students from a particular school, type at least five characters of the school's name (including spaces) or County-District-School code to get selectable values.

1. Select the [SEARCH] button.

**Note:** Check your California Longitudinal Pupil Achievement Data System (CALPADS) student records if students are not listed.

When the results appear, you can select the [View] magnifying glass icon to view a student's demographic data as they appear in CALPADS. While these data are not editable, you can determine whether any updates are required in CALPADS. The Student Profile screen is shown in Figure 31.
Note that student demographic data were imported from the California Longitudinal Pupil Achievement Data System (CALPADS) and cannot be edited in the Test Operations Management System (TOMS). Any change to student demographic data must be made in CALPADS. Data updates should show up in TOMS on the morning of the second business day after the data were changed in CALPADS.

Figure 31. **Student Profile screen**
Chapter 7. Ordering Test Materials
Ordering Test Materials | Approving Orders

Approving Orders

Additional Resources:
- English Language Proficiency Assessments for California Web Site—http://www.elpac.org/

Module Overview

Use the [Orders] tab approve orders, view summary orders, view and track orders, and place supplemental orders.

There are three windows for ordering materials. The Round 1 and Round 2 windows determine when the initial shipment is processed and shipped. An LEA can order test materials in either the Round 1 or Round 2 window, but not both. The Supplemental Order window is available for any additional orders that must be placed after the initial order.

Approve an Order

Take these steps to approve an order in either Round 1 or Round 2.

Step 1. Select criteria for the order (Orders > Select Criteria).

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner.

2. Select the [Orders] button in the left navigation bar to open the Approve Order Counts for LEA Web form; begin by selecting criteria to open the order (see Figure 32).
3. Select the LEA, test administration, and testing program (Summative or Initial Assessment).

4. Select the [Continue] button.

5. If there is no LEA ELPAC Coordinator assigned, you will see a pop-up message asking that one be assigned by contacting the ELPAC Customer Support Center. Select [Close] and continue when a coordinator has been assigned.

6. Confirm the LEA’s primary shipping address in the confirmation pop-up message (see Figure 33). Selecting [EDIT] opens the [Edit] tab in the View and Edit Organizations Web form, where you can edit the primary shipping address. If you choose this option, you will have to repeat step 2 to continue with your supplemental order, or select [CONFIRM] to continue.

Figure 32. Select criteria for order approval

Figure 33. Address confirmation box
Step 2. Download, review, update, and then upload the Material Counts Report Template to TOMS (Orders > Select Criteria > Upload).

Note: Once the order has been approved, it is no longer possible to upload the Material Counts Report Template. However, this file is still available for download and review.

Prepare the materials counts for the LEA by downloading the Materials Counts Report Template (see Figure 34).

![Figure 34. Download the Material Counts Report Template](image)

1. Select the [Download Material Counts Report Template] button to download the preselected order counts for the schools in your LEA. Note the following about the Material Count Report Template:
   - Suggested material counts for grades one through twelve are based on the number of English learner (EL) students shown in CALPADS for the school for the current year.
   - Suggested materials counts for kindergarten are based on the number of kindergarten California English Language Development Tests returned by the school in the previous year.
   - If a school moves out of the LEA or becomes inactive after the first download of the template, the LEA ELPAC Coordinator should edit the counts to make it zero for that school before uploading the file.
   - If a school is added to the LEA after the first download of the template, the LEA ELPAC Coordinator should use the supplemental order process to place a materials order for this school.
   - Because the template is an .xlsx file, it must be edited in Excel 2007 or later.

2. Save the .xlsx file to a local location.

3. Open the file. The file contains tabs for kindergarten through grade twelve. Columns in the file, which is shown in Figure 35, are as follows:
4. Follow the instructions at the top of each worksheet in the spreadsheet to review and amend counts for standard, braille, and large print materials.

5. For each school, two columns are populated and fixed: the CALPADS and Last Year columns which contain information on the number of English Learners in each school, and information on the number of students for whom English language proficiency assessments were returned in the previous year.

6. Note that because directions are fixed and must remain visible, the schools begin in Row 10 and may not be visible without manipulation (shrink the spreadsheet, or use a larger monitor).

7. Save the spreadsheet.

8. In the “Validate File” section of the Approve Order Counts for LEA (Upload) Web form, select the [Browse] (Internet Explorer or Firefox) or [Choose File] (Chrome) button see Figure 36).
9. Confirm that the correct file is selected, and then select the [VALIDATE] button to upload the Material Counts Report Template.

10. Subsequent downloads of the Materials Counts Report Template will show any edits that were made previously.

Figure 37 shows the results of the file validation. Key columns are Errors and Warnings. Warnings will not prevent the file from validating. The warning will either advise that there is a school in the file that is no longer included in the LEA; or that a number entered into the Standard column exceeds the system proposed count by 10 percent. This may result in excess material charges to the LEA.

However, if there are one or more errors in the Errors column after validation, you will receive an e-mail notification with the number of errors in the file; take one of the following actions:

1. Select the number in the Errors column corresponding to a file to see any errors in the submitted file.
2. In the Actions column, select the [Download] down-arrow icon to download a .csv file that contains a list of the errors in the submitted file.

3. Correct the errors and then revalidate your file.

4. You may delete the file by selecting the [Delete] trash can icon.

If there are zero (0) errors in the Errors column after validation, select the [UPLOAD] button to upload your file into TOMS.

Your file will appear in the “Uploaded Files” section of the screen after it has been uploaded. If there are one (1) or more errors in the Errors column, revalidate the file and upload again. An unsuccessful upload is usually due to a network issue or system error. You will receive an e-mail verifying the upload from elpac@ets.org that includes whether the upload was successful.

**Step 3. Approve the Order.**

1. Select the [CONTINUE] button at the bottom of the Approve Order Counts for LEA (Upload) Web form to move the order into the final approval stage (see Figure 38). Note that this button is disabled until the Material Counts Report Template has been downloaded.

![Figure 38. Approve order](image-url)
2. Review the final order in the grid on the Approve Order Counts for LEA (Approve Order) Web form. The order is shown by grade and Test Book type.

3. Select the [APPROVE] button to approve the order or the [BACK] button to return to the previous Web form to upload an amended order.

**View Summary Orders**

View the materials that will be sent to the LEA using the View Summary Orders function. By selecting the magnifying glass on the right of the summary order row, the user can see information about the orders coming to them. This information includes information about the organization for the order, who ordered the materials, the shipping information, and the materials that are being shipped.

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner.

2. Select the [Orders] button in the left navigation bar and then the [View Summary Orders] button to open the View Summary Orders Web form; begin by selecting the LEA and testing program to open the order (see Figure 39).

![Figure 39. Select criteria to view summary order](image)

3. The “Results” section that appears in Figure 40, includes the following columns:
   - Organization Name
   - Testing Program
   - Order Type (the round or supplemental)
   - Order Date
   - Status
   - Action
4. Select the [View] magnifying glass icon to select an order to review.

5. The View Order screen shows information about the organization as well as the list of testing materials. These will include:
   - Test Books (T/B)
   - Answer Books (A/B)
   - Examiner’s Manuals (EM)
   - Braille bundle (BDL BRL) (includes all materials needed to administer braille assessments)
   - Large-print bundle (BDL L/T) (includes all materials needed to administer large print assessments)

6. Select the [BACK] button to return to the View Order screen.

Not listed on this screen are the variety of materials needed for the return of the test materials—such as return instructions and prepopulated and blank Group Identification Sheets—from the school and LEA.

An overage is applied to the materials after the order has been approved. This overage is calculated by an algorithm and will not count towards any excessive order charges that are charged to the LEA. It provides extra materials for students who enroll after the order has been approved and who need to be tested.

**View and Track Orders**

In the View & Track Orders section, a user can look at all orders that have been created for the organizations they belong to based on permissions. Take the following steps to view and track orders:

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner.

2. Select the [Orders] button in the left navigation bar and then the [View & Track Orders] button to open the View Orders Web form; begin by selecting the LEA, testing program, and other criteria to see either all the orders that have been approved or those that meet the criteria entered (see Figure 41). Criteria for searching include the following:
• Test administration
  – Testing year
• Testing program
  – Initial
  – Summative
• Order number
• Order type
  – Round 1
  – Round 2
  – Supplemental

• Test form type
  – Standard
  – Special version
• Order status
  – Processed
  – Dispatched
  – Delivered
  – Pending
  – Processing

Figure 41. Results to view and track

3. Select the [View] magnifying glass icon to see the summary of the order or the [Tracking] green-x icon for the United Parcel Service tracking number as a link that you can select to track the shipment.
Place a Supplemental Order

LEAs can place supplemental orders for additional materials as needed once the Supplemental Orders window has opened.

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner.

2. Select the [Orders] button in the left navigation bar and then the [Place Suppl. Orders] button to open the Place Supplemental Orders (Place Orders) Web form; begin by selecting the LEA, test administration, testing program, and test form type (see Figure 42).

3. After you have entered your criteria, select [Continue].

4. Confirm the LEA’s primary shipping address in the confirmation pop-up message (Figure 43). Selecting [EDIT] opens the [Edit] tab in the View and Edit Organizations Web form, where you can edit the primary shipping address. If you choose this option, you will have to repeat step 2 to continue with your supplemental order. Or, select [CONFIRM] to continue.

5. On the Place Orders (Order Quantities) Web form, enter the quantities of the Supplemental materials you want to order (see Figure 44). Select a grade from the
Select Grade drop-down list to limit the individual materials shown. Whether you selected to place a supplemental order for standard or special version materials, the list includes the option to order additional coordinator kits for both LEA ELPAC Coordinators and Site ELPAC Coordinators.

6. Select [CONTINUE] when you have finished entering quantities.

7. A warning may appear that advises that the number entered in the Quantity field exceeds the total proposed material count for a school or grade by more than 10 percent, which may result in excess material charges to the LEA. Select [CLOSE].

8. Review the order on the Place Orders (Review Order) screen (see Figure 45).
9. If you agree with the quantities ordered, select the [SUBMIT ORDER] button. If not, select the [EDIT ORDER] button to make additional changes.

Figure 45. Submit a Supplemental order
Chapter 8. Ordering Pre-Identification Labels
Ordering Pre-ID Labels

Additional Resources:

- The English Language Proficiency Assessments for California (ELPAC) Web Site—http://www.elpac.org/

Module Overview

In addition to test materials, local educational agencies (LEAs) use the Test Operations Management System (TOMS) to request Pre-identification (Pre-ID) labels that will be affixed to Answer Books and used to track student testing and assign results. While they are not mandatory, Pre-ID labels contain all the student information needed and preclude the need for hand-marking this information on the Answer Books.

Note the following about ordering Pre-ID labels:

- Pre-ID labels can be ordered in two Rounds.
  – During Round 1, which runs from January 2–April 9, 2018, Pre-ID labels cost $0.38.
  – During Round 2, which runs from April 10–May 14, 2018, labels will cost $0.44.
- Round 1 labels should contain the LEA’s primary order. Round 2 labels should be ordered only for those students who were enrolled after Round 1 labels were ordered or whose California Longitudinal Pupil Achievement Data System data have changed since the Round 1 order.
- There is no setup fee associated with Pre-ID labels.
- The process for approving Pre-ID labels is the same for both Round 1 and Round 2 Pre-ID. Round 1 approval occurs in the “Round 1 Pre-ID Labels” section of the Approve Pre-ID Labels Web form; Round 2 approval occurs in the “Round 2 Pre-ID Labels” section of the Approve Pre-ID Labels Web form.
- Once the Round 2 window closes, the LEA can no longer order Pre-ID labels.

Approving Pre-ID Labels

Take these steps to approve (order) Pre-ID labels:

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner.
2. Select the [Pre-ID Labels] button in the left navigation bar to open the Approve Pre-ID Labels Web form; begin by selecting criteria to open the order (see Figure 46).
3. Select an Organization for which the Pre-ID labels are to be generated.

4. Select the [CONTINUE] button.

5. Confirm the LEA’s primary shipping address in the confirmation pop-up message (see Figure 47). Selecting [EDIT] opens the [Edit] tab in the View and Edit Organizations Web form, where you can edit the primary shipping address. If you choose this option, you will have to repeat step 2 to continue with your Pre-ID approval, or select [CONFIRM] to continue.

6. When the Pre-ID Approval Web form opens, (see Figure 48) select the [Pre-ID Labels Preview Report] link in the "Pre-ID Labels" section to download the report and verify that the student data that will be sent for label generation. This is the same report that can be downloaded on the LEA Reports Web page (and is described in the “EL Round 1 Pre-ID Labels Preview Report” subsection of Chapter 9 Administrative Reports).

7. Once you have reviewed the report, enter a purchase order (PO) number in the PO Number field (shown as a blank field in the “Round 2 Pre-ID Labels” section).

8. Select the [Approve] button before the date in the Latest Order Approval Date field to generate the labels and then [OK] to finalize the approval.

9. If the LEA has not approved Pre-ID labels in Round 1, or if changes are required in Round 2, approve labels in Round 2 by attaching another PO for any charges and selecting the [Approve] button.
Ordering Pre-Identification Labels

Approve Pre-ID Labels

Take these steps to approve your local educational agency’s (LEAs) English Language Proficiency Assessments for California (ELPAC) Pre-ID labels:
1. Select an Organization for which the Pre-ID labels are to be generated.
2. Select the [CONTINUE] button.
3. Select the [Pre-ID Labels Preview Report] link in the “Pre-ID Labels” section below to verify the student data that will be sent for label generation.
4. Once you have reviewed the report, enter a purchase order (PO) number in the PO Number field.
5. Select the [Approve] button before the date in the Latest Order Approval Date field to generate the labels.

Organizations
Sample Unified [0000000000000000] X

Round 1 Pre-ID Labels

EL Round 1 Pre-ID Labels Preview Report
You may download the Round 1 Pre-ID Labels Preview Report now or download it anytime from the LEA Reports Web form by selecting the [Reports] button and then the [LEA Reports] button in the left navigation bar, and then requesting a new report in the "EL Round 1 Pre-ID Labels Preview Report" section.

Latest Pre-ID Label Order
Approval Date for Round 1
Oct 12, 2017

<table>
<thead>
<tr>
<th>Approve</th>
<th>Approved Date/Time</th>
<th>Approver</th>
<th>PO Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>Sep 22, 2017, 11:17:32 AM</td>
<td><a href="mailto:ELPAC@ca.org">ELPAC@ca.org</a></td>
<td>2017-000000-EL10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Round 1 Pre-ID Label Orders Approved By LEA date:</th>
</tr>
</thead>
<tbody>
<tr>
<td>9/16/2017</td>
</tr>
<tr>
<td>9/30/2017</td>
</tr>
<tr>
<td>10/1/2017</td>
</tr>
<tr>
<td>10/12/2017</td>
</tr>
</tbody>
</table>

Round 2 Pre-ID Labels

EL Round 2 Pre-ID Labels Preview Report
You may download the Round 2 Pre-ID Labels Preview Report now or download it anytime from the LEA Reports Web form by selecting the [Reports] button and then the [LEA Reports] button in the left navigation bar, and then requesting a new report in the "EL Round 2 Pre-ID Labels Preview Report" section.

Latest Pre-ID Label Order
Approval Date for Round 2
May 14, 2018

Round 2 Pre-ID Label Orders Approved By LEA date:

<table>
<thead>
<tr>
<th>Round 2 Pre-ID Label Orders Approved By LEA date:</th>
</tr>
</thead>
<tbody>
<tr>
<td>4/30/2018</td>
</tr>
<tr>
<td>5/14/2018</td>
</tr>
</tbody>
</table>

Figure 48. Pre-ID approval information
Chapter 9. Administrative Reports
Download English Language Proficiency Assessments for California (ELPAC) Reports

Additional Resources:
• The ELPAC Web Site—http://www.elpac.org/

The Test Operations Management System (TOMS) offers several reports to assist in planning test administration and tracking student results, at both the local educational agency (LEA) and school levels.

The reports available for LEA ELPAC Coordinators are:

• EL LEA User List Report
• EL School-Level Student Demographics Report
• EL LEA-Level Student Demographics Report
• EL LEA Coordinator Report
• EL Pre-ID Labels Quantity Report
• EL Round 1 Pre-ID Labels Preview Report
• EL Round 2 Pre-ID Labels Preview Report

Take the following steps to download a report:

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner.

2. Select the [Reports] button in the left navigation bar and then either the [LEA Reports] button (for the LEA reports) or the [SITE Reports] button (for the site report) to open the appropriate Web form (see Figure 49).

3. Select the LEA or school with which the user is associated by selecting the [Select Organization] link.
   a. To view the LEA’s information, type at least five characters of the LEA’s name (including spaces) or the County-District-School (CDS) code for the LEA.
   b. To view a school’s information that is in your organization, type at least five characters of the school’s name (including spaces) or the CDS code of the school.

4. Locate and download your report by selecting the [DOWNLOAD REPORT] button. Note that certain LEA-level reports must be requested in advance by selecting the [REQUEST NEW REPORT] button; you will be notified of their availability via e-mail.
Note: When you open your file, if Excel shows your school and LEA codes in scientific notation (e.g., 1.2408E+12), take the following steps to reformat to show the whole number:

1. Highlight the School CDS or LEA CDS column.
2. Select the column with your right mouse button.
3. Select Format cells… from the pop-up menu.
4. In the Category list, select “Number.”
5. Change the Decimal places field to “0” (zero).
6. Select [OK].
7. Repeat for the other CDS code.

EL LEA User List Report

Figure 50. “EL LEA User List Report” section on the LEA Reports Web form

This report generates a list of users associated to the LEA in the user upload format. To download the report, select an organization and school year (current or previous; indicated in Figure 50), and then select the [DOWNLOAD REPORT] button. Select Previous School Year when you intend to download the file containing a list of users from the past administration that can be modified to change user roles and/or to remove users who are no longer associated with the LEA.

The EL LEA User List Report contains the following information about individuals assigned to roles within ELPAC TOMS:

- First Name
- Last Name
- CDS Code
- E-mail Address
- Telephone Number
- Role in Organization
EL School-Level Student Demographics Report

This report is available to Site ELPAC Coordinators. Select a school before downloading this report of student demographics information for a school. The section from the LEA Reports Web form is shown in Figure 51.

What follows are column names within the EL School-Level Student Demographics Report:

- LEA CDS Code
- LEA Name
- School CDS Code
- School Name
- SSID
- CALPADS Enrolled Grade
- Grade Assessed
- American Indian or Alaska Native
- Asian
- Black or African American
- Filipino
- Hispanic Or Latino
- Native Hawaiian Or Other Pacific Islander
- Two or More Races
- White
- US School Entry Date
- English Language Proficiency Level
- Migrant Status
- Parent Education Level
- Special Education
- 504 Plan
- English Language Acq Status
- EL
- EL Start Date
- EL Exit Date
- Primary Disability Code
- CALPADS Date of Birth
- Date of Birth for Testing
- Local Student ID
Download this report to see demographics for students at all schools in your LEA. Select your organization and then select the [REQUEST NEW REPORT] button to generate a new report. Return to this Web form after receiving an e-mail notification that the report is ready and then select the [DOWNLOAD REPORT] button to download a .csv file that shows the demographics for students in selected LEA. Note: Files may be very large and take time to process depending on the size of your LEA’s student demographics. For the best performance, make sure to select the schools and the columns from the list provided, and allow time for the download to complete before submitting another request.

**Important:** If you are requesting a new report by selecting [REQUEST NEW REPORT], you will receive an e-mail notification when it is ready for download.

![Select Organization](image)

**Figure 52.** “EL LEA-Level Student Demographics Report” section on the LEA Reports Web form

You also have the option of including specific demographic characteristics in the report such as specific races/ethnicities, English language proficiency level, and English learner status; the scrolling list is circled in Figure 52. To select multiple options, press the [Shift] key while you are making selections. This report must be requested.

The default columns in the EL LEA-Level Student Demographics Report contain Statewide Student Identifier and School Name data. Optional columns are as follows:

- CALPADS Enrolled Grade
- Grade Assessed
- LEA CDS Code
- LEA Name
- School CDS Code
- American Indian or Alaska Native
EL LEA Coordinator Report

This report allows a user to see each school in the LEA as well as the total number of students enrolled per grade. The section from the LEA Reports Web form is shown in Figure 53. What follows are column names within the EL LEA Coordinator Report:

- LEA Name
- LEA Code
- SCHOOL Name
- SCHOOL Code
- Total Students enrolled in grade KN
- Total Students enrolled in grade 01
- Total Students enrolled in grade 02
- Total Students enrolled in grade 03
- Total Students enrolled in grade 04
- Total Students enrolled in grade 05
- Total Students enrolled in grade 06
- Total Students enrolled in grade 07
- Total Students enrolled in grade 08
- Total Students enrolled in grade 09
- Total Students enrolled in grade 10
- Total Students enrolled in grade 11
- Total Students enrolled in grade 12
EL Pre-ID Labels Quantity Report

This report displays Round 1 Pre-ID label and Round 2 Pre-ID label quantities that have been sent for label generation (see Figure 54). What follows are column names within the EL Pre-ID Labels Quantity Report:

- LEA CDS Code
- LEA Name
- School CDS Code
- School Name
- Charter Status
- Grade
- Test Program
- Round 1 Pre-ID Label Count
- Round 1 Pre-ID LEA Approval Date
- Round 2 Pre-ID Label Count
- Round 2 Pre-ID LEA Approval Date
- EL Round 1 Pre-ID Labels Preview Report

EL Round 1 Pre-ID Labels Preview Report

Access the student information used to generate Round 1 Pre-ID labels by downloading the EL Round 1 Pre-ID Labels Preview Report (see Figure 55). Data include the cost, in cents, per label.

What follows are column names within the EL Round 1 Pre-ID Labels Preview Report:

- Program
- Last Name
- First Name
- Middle Initial
- School Name
- District Name
- LEA CDS Code
- SSID
- Date of Birth
- Grade
- School CDS Code
- Local Student ID


- Cents/Label

**EL Round 2 Pre-ID Labels Preview Report**

![EL Round 2 Pre-ID Labels Preview Report](image)

This report displays the student data to be used for Round 2 Pre-ID label generation for a local educational agency (LEA).

**Organization**

- Select Organization

![Search Icon](image)

![Close Icon](image)

**Download Report**

**Figure 56. “EL Round 2 Pre-ID Labels Preview Report” section on the LEA Reports Web form**

Access the student information used to generate Round 2 Pre-ID labels by downloading the EL Round 1 Pre-ID Labels Preview Report (see Figure 56). Data include the cost, in cents, per label.

What follows are column names within the EL Round 1 Pre-ID Labels Preview Report:

- Program
- Last Name
- First Name
- Middle Initial
- School Name
- District Name
- LEA CDS Code
- SSID
- Date of Birth
- Grade
- School CDS Code
- Local Student ID
- Cents/Label
Chapter 10. Audio Modules
Availability of Secure Audio Modules in the Test Operations Management System (TOMS)

Additional Resources:

- The English Language Proficiency Assessments for California (ELPAC) Web Site—http://www.elpac.org/

Note: Directions for ELPAC Test Examiners on using audio modules during testing can be found in the ELPAC Examiner's Manual. Information about troubleshooting difficulties with the audio modules can be found in the ELPAC Test Administration Manual.

During the Speaking and the Listening portions of the ELPAC in grades three through twelve, the ELPAC Test Examiner plays an audio file for students as part of the assessment. These secure files are available for the Test Examiner to play through the Audio Modules Web page in TOMS.

ELPAC Test Examiners are encouraged to test their audio systems by playing the sample audio to determine the appropriate volume, sound quality, and placement of speakers during testing. Then, during test administration, the user can access and play the module associated with the tests they are administering by selecting the appropriate module, assessment type, grade/grade span, and test version.

Warning: Audio files are secure test materials and must not be saved or recorded. Instead, they are only to be played from TOMS during the test session.

Accessing Audio Modules

1. Use an Internet browser to go to the ELPAC Web Site and select the [Test Operations Management System (TOMS)] button on the right side of the screen under the graphic banner.

2. Select the [Audio] button in the left navigation bar to open the Audio Modules Web form (see Figure 57).
Using Audio Modules

Hearing Sample Audio

The sample audio which repeats, “This is a test of the ELPAC recorded audio sound level,” should be used to test speaker setup. This should be done just before administering the Listening domain to students.

Take the following steps to listen to the sample audio:

1. Select the [PLAY SAMPLE] button (see Figure 58).

Figure 58. Request the sample audio

2. Wait while the sample becomes available.

3. When the audio has finished its setup, select the [Play] arrow [▶] icon in the Audio Playback interface (see Figure 59). You can pause the audio by selecting the [Pause]
parallel line icon, only in the event of an interruption (e.g., announcements over the intercom, fire drill).

4. Adjust the volume as necessary by moving the slider next to the [Volume] speaker icon.

5. When you are satisfied with the volume of the audio, select the [Cancel] button to close the Audio Playback interface.

**Hearing Audio Modules**

Only ELPAC Test Examiners are permitted to access and administer the Listening domain of the test. To play the correct Listening module, ELPAC Test Examiners need to know the grade and form of the assessment they are to administer. ELPAC Test Examiners can access this information from their Site ELPAC Coordinator.

Take the following steps to play an audio module during the administration of the Listening domain:

1. Select the module, assessment, grade, and test type by selecting the appropriate radio buttons. Radio button options are listed in Table 5; the “2017–18 Assessments” section of the Audio Modules Web form is shown in Figure 60.

<table>
<thead>
<tr>
<th>Category</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module</td>
<td>• Listening Module</td>
</tr>
<tr>
<td></td>
<td>• Speaking Module</td>
</tr>
<tr>
<td>Assessment</td>
<td>• Summative Assessment</td>
</tr>
<tr>
<td>Grade</td>
<td>• Grades 3–5</td>
</tr>
<tr>
<td></td>
<td>• Grades 6–8</td>
</tr>
<tr>
<td></td>
<td>• Grades 9–10</td>
</tr>
<tr>
<td></td>
<td>• Grades 11–12</td>
</tr>
<tr>
<td>Test</td>
<td>• Standard</td>
</tr>
</tbody>
</table>
2. Confirm the audio selection by selecting [YES] in the *Please Confirm* pop-up confirmation box (see Figure 61). Select [NO] to cancel the request without starting the audio.

3. When the audio has finished its setup, select the [Play] arrow [►] icon in the Audio Playback interface (see Figure 62). You can pause the audio during playback by selecting the [Pause] parallel line [∥] icon.
4. Adjust the volume as necessary by moving the slider next to the [Volume] speaker [_sound_icon] icon.

5. When testing is complete, select the [Cancel] button to close the Audio Playback interface.
Chapter 11. Other Supports and Resources
Additional Resources Available in the Test Operations Management System (TOMS)

Additional Resources:
- ELPAC Web Site—http://www.elpac.org/
- ELPAC Summative Assessment Administration and Scoring Moodle Training Site—https://moodle.elpac.org/

There are additional resources available in TOMS to support Local Educational Agency (LEA) ELPAC Coordinators, Site ELPAC Coordinators, and ELPAC Test Examiners.

Test Operations Management System (TOMS) Help

Select the [Help] question mark icon at the top of the TOMS application window to view access information to the ELPAC Customer Support Center as well as links to this manual, and the ELPAC and TOMS Frequently Asked Questions documents (see Figure 63).

Training Resources—Moodle Training Site

Select the [Training Resources] button in the TOMS left navigation bar to open the external ELPAC Summative Assessment Administration and Scoring Moodle Training Site in a separate browser tab. This Web site contains links to courses and materials that will assist LEA and Site ELPAC Coordinators and ELPAC Test Examiners in their administration of these assessments (see Figure 64).
Select the [Summative Assessment Training Resources] link to see a list of the courses available. Select a link from this list to access the course or materials. Note that because these resources are secure, a Moodle Training Site logon is required.

**Training and Administration Resources—ELPAC.org**

TOMS also includes a link to the [ELPAC Web Site](http://elpac.com). It can be accessed by selecting the [ELPAC.com] button, which will open this Web site in a separate browser tab. [ELPAC.org](http://elpac.com) includes news and tips helpful for coordinators, information about the ELPAC, resources and information about test administration, forms that are required, additional trainings and resources, and a calendar. A sample of the portal Web page is shown in [Figure 65](#).

![Figure 65. Sample ELPAC.org portal Web page](image-url)